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Using Constraints Tutorial

ﬁ IMPORTANT: This tutorial requires the use of the Kintex®-7 family of devices. You will
need to update your Vivado® tools installation if you do not have this device family
installed. Refer to the Vivado Design Suite User Guide: Release Notes, Installation, and
Licensing (UG973) for more information on Adding Design Tools or Devices.

Overview

This tutorial is comprised of two labs that demonstrate aspects of constraining a design in the Vivado®
Design Suite. The constraints format supported by the Vivado Design Suite is called Xilinx® Design
Constraints (XDC), which is a combination of the industry standard Synopsys® Design Constraints and
proprietary Xilinx constraints.

-t
e

m VIDEO: You can also learn more about defining constraints in the Vivado Design Suite by
viewing the quick take video at Vivado Design Constraints Overview

TRAINING: Xilinx provides training courses that can help you learn more about the concepts
presented in this document. Use these links to explore related courses:

:l e Essentials of FPGA Design

e Vivado Design Suite Static Timing Analysis and Xilinx Design Constraints

e Vivado Advanced Tools and Technigues

XDCs are not just simple strings; they are Tcl commands that the Vivado Tcl interpreter sequentially
reads and parses. You can enter design constraints in several ways at different points in the design flow.
You can store XDCs in one or more files that can be added to a constraint set in Vivado Project Mode,
or read the same files directly into memory using the read_xdc command in Non-Project mode. For
more information on Project and Non-Project modes, refer to the Vivado Design Suite User Guide:
Design Flows Overview (UG892). With a design open in Vivado tools, you can also type constraints as
commands directly in the Tcl console when working in the Vivado IDE or at the Tcl command prompt
when working outside of the IDE. This is particularly powerful for defining, validating, and debugging
new constraints interactively in the design.

The Vivado Design Suite synthesis and implementation tools are timing driven. Having accurate and
correct timing constraints is vital for meeting design goals and ensuring correct operation. Because the
Vivado tools are timing driven, it is important to fully constrain a design, but not over-constrain, or
under-constrain it. Over-constraining a design can lead to long run-times and sub-optimal results
because the tool can struggle with unrealistic design objectives. Under-constraining a design can cause
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the Vivado tools to perform unnecessary optimizations, such as examining paths with multicycle delays
or false paths, and prevent focus on the real critical paths.

This tutorial discusses different methods for defining and applying design constraints.

Tutorial Design Description

The sample design used throughout this tutorial consists of a small design called
project_cpu_netlist. There is a top-level EDIF netlist source file, as well as an XDC constraints file.

The design targets an XC7K70T device. A small design is used to allow the tutorial to be run with
minimal hardware requirements and to enable timely completion of the tutorial, as well as to minimize
the data size.

Hardware and Software Requirements

This tutorial requires that the 2014.3 Vivado Design Suite software release or later is installed. The
following partial list describes the operating systems that the Vivado Design Suite supports on x86 and
x86-64 processor architectures:

Microsoft Windows Support:

e Windows 7 and 7 SP1 Professional (32-bit and 64-bit), English/Japanese
e Windows 8.1 Professional (64-bit), English/Japanese

Linux Support:

e Red Hat Enterprise Workstation 5.8 - 5.10 (32-bit and 64-bit)
Red Hat Enterprise Workstation 6.4 and 6.5 (32-bit and 64-bit)
SUSE Linux Enterprise 11.1 - 11.2 (32-bit and 64-bit)

Cent OS 6.4 and 6.5 (64-bit)

Ubuntu Linux 14.04 LTS (64-bit)

Refer to the Vivado Design Suite User Guide: Release Notes, Installation, and Licensing (UG973) for a
complete list and description of the system and software requirements.

Preparing the Tutorial Design Files

You can find the files for this tutorial in the examples directory of the Vivado Design Suite software
installation, at the following location:

<Vivado_install_area>/Vivado/<version>/examples/Vivado_Tutorial.zip
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Extract the ZIP file contents from the software installation into any write-accessible location.

The location of the extracted Vivado_Tutorial directory is referred to as the <Extract_Dir>in
this Tutorial.

You can also extract the provided ZIP file at any time to restore the files to their starting condition.

Note: You will modify the tutorial design data while working through this tutorial. You should use
a new copy of the original Vivado_Tutorial directory each time you start this tutorial.
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Lab 1: Defining Timing Constraints

Introduction

In this lab, you will learn two methods of creating constraints for a design. You will be using the
Kintex-7 CPU Netlist example design that is included in the Vivado IDE.

Step 1: Opening the Example Project

Open Vivado IDE:

On Linux:

1. Change to the directory where the lab materials are stored:
cd <Extract Dir>/Vivado_Tutorial

2. Launch the Vivado IDE: vivado

On Windows,
1. Launch the Vivado Design Suite IDE:
Start > All Programs > Xilinx Design Tools > Vivado 2014.x > Vivado 2014.x

Note: Your Vivado Design Suite installation may be called something other than Xilinx Design
Tools on the Start menu.

Note: As an alternative, click the Vivado 2014.x Desktop icon to start the Vivado IDE.

The Vivado IDE Getting Started page contains links to open or create projects and to view
documentation.
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2. From the Getting Started page, click Open Example Project and select the 7-Series Kintex > CPU
(Synthesized) design, as shown in Figure 1.

Open Project Open Example Project
7-Series Webpack »
7-Series Kintex 3 BFT Core Small RTL project
7-Series Virtex L4 Wavegen (HDL) Small IP project
Embedded Design... CPU (HDL) Large mixed-language RTL project
| E— . ’ ! .
Hardware Manager S CPU (Synthesized) Large synthesized netlist project

Figure 1: Open Example Project

A dialog box appears stating that the project is read-only.

3. Click Save Project As to specify a project name and location, as shown in Figure 2.

gl*'f_:. Save Project As @

,'0‘, Save this project to a new name and location,

Name and Location
Project name: project_cpu_netlist
Project location: | C:/Data/Vivado_Tutorial l:J
Create project subdirectory

Project will be created at: C:/Data/Vivado_Tutorial fproject_cpu_netlist

o

Figure 2: Save Project As

4. Specify the following, and click OK:
0 Project name: project_cpu_netlist

0 Project location: <Extract_Dir>
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The Vivado IDE displays the default view of the opened project, as shown in Figure 3.

2. project_cpu_netlist - [C:/Data/Vivado_Tutorial/project_cpu_netlist/project_cpu_netlistxpr] - Vivado 2014.2
Fle Edit Flow Tools Window Layout View Help

g oeRBB X DS X X G |SoefutLayout & Y =
Flow Navigator <« | Project Manager - project_cpu_netist x|
QT e Sources — O % | [EProjectsummary x O %
A pho gl A =

|‘ Project Manager ‘ qg@ldﬁllz = Project Settings Edit %
S Mo = Design Sources (1) =] -

3 Project Settings & Constaints (2) Project name: project_cpu_netist

{5 Add Sources - Simulation-Orly Sources (1) Product family:  Kintex-7

Project part: XCAATObE76-2

4 Simulation

3 Simulation Settings

Top module name:  top

TImplementation x
(I} Run Simulation
Status: =} Notstarted
4 Netist Analysis
~ ) Messages: No errors o warnings
b @Y Open Synthesized Design Part: XCTk70tbgs76-2
| Strategy: vivado Implementation Defaults
4 Implementation Libraries | Compile Order | E

Constraints: constrs 2

£ Implementation Settings - 4 constrs 2
& Sources | Templates E Incremental Compile: Mone

[» Run Implementation

Properties —Owe =
> @ Open Implemented Design e DRC Violations & Timing a
« +[Ex
4 Program and Debug
DRC information is not available because it hasn't been run Timing information is not available because it hasn't been run
4F% Bitstream Settings 3
¥ Generate Bitstream i
> g% Open Hardware Manager L By bl £
Utlization information is not available because it hasn't been run Power information is not available because it hasn't been run
Design Runs —Ouw X
A | Name Constraints  WNS TNS WHS THS TPWS FaledRoutes LUT FF  BRAM  DSP  Start Elapsed  Status
| = impl_1 constrs_2 Not started
g
=
>

<[ i ]

I3 Tel Console | © Messages | G Log | 2 Reports', 3> Design Runs

Figure 3: Project Summary Window
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Step 2: Defining Constraint Sets and Files

Start by creating a new constraint set and adding an empty XDC constraints file to it. The sample design
already contains two constraint sets, but you do not use them for this lab.

1
2.

From the Flow Navigator, select Add Sources in the Project Manager section.

From the list displayed in the Add Sources dialog box, select Add or Create Constraints and click
Next.

From the Add or Create Constraints dialog box, use the Specify Constraint Set: drop down menu to
select Create Constraint Set as shown in Figure 4.

Specify Constraint Set: | &= constrs_2 (acfive) -
Constraint File  Locati{ constrs_1 o

i constrs_2 (active)

%: Create Constraint Set...

Figure 4: Create Constraint Set

In the Create Constraint Set Name dialog box, specify the constraint set name as Iab1 and click OK.
Enable the Make active checkbox.
Select Create File to add a new XDC file to the project. Enter timing as the file name. Leave the file

as <Local to Project>, and click OK. See Figure 5.

g‘-‘_ Add Sources

Add or Create Constraints
Spedfy or create constraint files for physical and timing constraint to add to your project.

Specify constraint set: | & lab1 - Make active

ConstraintFile  Location )
g-- Create Constraints File @

,0, Create a new constraints file and add it to your project

File type, name and location
File type: {4 XDC A4
File name: timing

File location: | &5 <Local to Project= -

oK l I Cancel

Figure 5: Constraints File Name

The timing.xdc file is added to the lab1l constraint set.
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7. Select Finish to complete the creation of the new constraint set and XDC file.

You should see the new constraint set and XDC file in the Sources window as shown in Figure 6. The
constraint set is made active as you directed when you created it.

8. Set the timing.xdc file as the target XDC file. All constraints added to the design will be saved in
the target XDC file. In the Sources window, right click the target.xdc and choose Set as Target
Constraint File from the context menu. See Figure 6.

u
®

Sources — O
o T m ey 14 [E
=I-i57 Design Sources (1]
| & EDIF (1
iffie top.edif (top)
—-{= Constraints (3]
: +|z| constrs_1 (1]

+-im constrs_2 (1)

- laba (1) (active]
: Y o timing.xdc
- Simulation-Only Sources (1)

= sim_1 (1)

-7 Verilog (1)

Libraries | Compile Qrder

4% Sources | ' Templates

Figure 6: Sources window

Step 3: Creating Timing Constraints

Open the synthesized design and use the timing constraints wizard. The timing constraints wizard
analyzes the gate level netlist and finds missing constraints. Use the timing constraints wizard to
generate constraints for this design.

1. From the Flow Navigator, select Open Synthesized Design.

2. Select Constraints Wizard from the Flow Navigator under the Synthesized Design section. The
introduction page of the Wizard will appear. This page describes the types of constraints that the
wizard will create.

3. After reading the page, click Next to continue.

4. The primary clocks page of the Timing Constraints wizard displays all the clock roots with a missing
clock definition. The wizard detected five missing clock constraints that are needed to time logical
paths, and four missing clock constraints that are only needed to verify pulse width and minimum or
maximum period requirements. The second category of clocks is optional and is shown in the
Constraints for Pulse Width Check Only table. For this example, do not add these last constraints.
Use Table 1 to fill in the periods of the five missing primary clocks in the design.
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Table 1: Values to use on the Primary Input Page of the Wizard

Primary Clock Period (ns)
mgtEngine/ROCKETIO_WRAPPER_i/gt0_ROCKETIO_WRAPPER_TILE_i/GTO_TXOUTCLK_OUT 12.8
mgtEngine/ROCKETIO_WRAPPER_i/gt0_ROCKETIO_WRAPPER_TILE_i/GT2_TXOUTCLK_OUT 12.8
mgtEngine/ROCKETIO_WRAPPER_i/gt0_ROCKETIO_WRAPPER_TILE_i/GT4_TXOUTCLK_OUT 12.8
mgtEngine/ROCKETIO_WRAPPER_i/gt0_ROCKETIO_WRAPPER_TILE_i/GT6_TXOUTCLK_OUT 12.8
sysClk 10.0

Each row of the wizard is a missing constraint. If you would prefer not to enter the constraint, you
can uncheck the box next to the constraint. If you would like more information about how the
wizard is finding these missing constraints, there is a reference button in the lower left-hand corner
of the wizard. The reference pages are context specific and contain more information about the
topologies the wizard is looking for and an explanation as to why the constraint is being suggested.

5. The completed page should look like Figure 7. Click Next to continue.

2. Timing Constraints Wizard @
Primary Clocks

Primary clocks usually enter the design though input ports. Specify the period and optionally a name and waveform (rising and falling edge times) to describe the duty cycle if '
not 50%. More info

Recommended Constraints

A Object Name Frequency (MHz)  Period (ns)  Rise At (ns)  Fall At (ns)
LS Il TXOUTCLK mgtEngine/ROCKETIO_WRAPPER_TILE_i/...I0_WRAPPER_TILE_i/GT0_TXOUTCLK_OUT 78.125 12.800 0.000 6.400
d Il TXOUTCLK mgtEngine/ROCKETIO_WRAPPER_TILE_i/...I0_WRAPPER_TILE_i/GT2_TXOUTCLK_OUT 78.125 12.800 0.000 6.400
) [¥] UL TXOUTCLK mgtEngine/ROCKETIO_WRAPPER_TILE if...I0_WRAPPER_TILE i/GT4_TXOUTCLK_OUT 78.125 12.800 0.000 6.400
NIl TXoUuTCLK mgtEngine/ROCKETIO_WRAPPER_TILE_i/...I0_WRAPPER_TILE_i/GT6_TXOUTCLK_OUT 78.125 12.800 0.000 6.400
8] sk sk oow] o oo so0)
Constraints for Pulse Width Check Only
aQ [C] object Name Frequency (MHz)  Period (ns)  Rise At (ns)  Fall At (ns)
L O] I T1E0_REFCLK_PAD_P_IN TILEO_REFCLK_PAD_P_IN undefined undefined
Z |[C] 1 Twe1_REFCLK_PAD_P_IN TILE1_REFCLK_PAD_P_IN undefined undefined
| I:‘ Il TILE2_REFCLK_PAD_P_IN TILE2_REFCLK_PAD_P_IN undefined undefined
[ I T1E3 REFCLK PAD_P_IN TILE3_REFCLK_PAD_F_IN undefined undefined

% Tcl Command Preview (5) | & Existing Create Clock Constraints (0)
@ | create_clock -period 12.800 -name mgtEngine/ROCKETIO_WRAPPER_TILE_j/gt0_ROCKETIO_WRAPPER_TILE_i/GTO_TXOUTCLK_OUT -waveform {0.000 6.400} [get_pins {mgtEnging

_ [
% create_clock -period 12.800 -name mgtEngine/ROCKETIO_WRAPPER_TILE_i/gt2_ROCKETIO_WRAPPER_TILE_i/GT2_TXOUTCLK_OUT -waveform £0.000 6.400} [get_pins {mgtEngine
o create_clock -period 12.800 -name mgtEngine/ROCKETIO_WRAPPER_TILE_i/gt4_ROCKETIO_WRAPPER_TILE_i/GT4_TXOUTCLK_OUT -waveform {0.000 6.400} [get_pins {mgtEngine
[

& create_clock -period 12.800 -name mgtEngine/ROCKETIO_WRAPPER_TILE_i/gté_ROCKETIO_WRAPPER_TILE_i/GT6_TXOUTCLK_OUT -waveform {0.000 6.400} [get_pins {mgtEngine

. create_clock -period 10.000 -name sysClk -waveform {0.000 5.000} [get_ports {sysCIk}]

< 1T Q=

[ < Back ][ Next > ][ Skip to Finish »> ] [ Cancel ]

Figure 7: Completed primary clocks page of the timing constraints wizard

6. The primary clock constraints have been added to the design. Next, the wizard looks for generated
clocks. Generated clocks are derived from primary clocks in the FPGA fabric. A good example
would be a binary counter used to create a divided clock. In this design, the wizard determined that
there are no unconstrained generated clocks.
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7. Click Next to continue. A forwarded clock is a generated clock on a primary output port of the
FPGA. These are commonly used for source synchronous buses when the capture clock travels with
the data. The wizard has also determined that there are no unconstrained forwarded clocks in the
design.

8. Click Next to continue. MMCM or PLL feedback delay outside the FPGA is used to compute the
clock delay compensation in the timing reports. The wizard did not find any unconstrained MMCM
external feedback delays in the design.

9. Click Next to continue.

Figure 8 shows the inputs page of the timing constraints wizard. There are three sections to the
page. In section A, you can see all the input ports that are missing input delay constraints in the
design. In this table, you select the timing template you would like to use to constrain the input. In
section B, you provide the delay values for the template. This section will change depending on the
template chosen in section A. Finally, in section C there are three tabs. One previews the Tcl
commands that will be used to constrain the design. A second tab shows input delay constraints
that already exist in the design. The third tab displays the waveform associated with the template.

#. Timing Constraints Wizard ==
Input Delays

Input delays describe relative phase between reference docks (usually board docks) and input signals at the FPGA boundary. Insccurate input delay valwes can make timing '
fail and affect implementation quality of results. More infp

Recommendid Constraints

‘J\ + | Interface o Smchromus ngnment Data R.dl? and Edge Deloy Porometers

B T —— ey s SO R, -

B[V B Unestat..d_1_[*] [l sysCik System = Edge = Single Rise - ey g undefined | na
| & vStaws_pad_0_i(*] Il sysCk System ~ Edge = Single Rise »

“ W] & vstatus_pad_1_i{*] [l sysCik System ~ Edge ~ Single Rise B too_miax: undefined | ns
| B RxActive_pad_0_| M sysCik System ~ Edge ~ Single Rise - tree_dby_min: undefined | ns
o | @ RotActive_pad_1_j I sysck Syetem = Edge = Single Rise - -
o | B RxError_pad_0_i I syscik System = Edge ~ Single Rise - troe_dhy_moc uilefinad |1
o | B RError_pad_1_i M. sysCik A System ~ Edge ~ Single Rise ~
7| B Roovalid_pad 0_i 1 sysCik System ~ Edge ~ Single Rise v
| B Rvalid_pad_1_| M sysCik System ~ Edge ~ Single Rise - L
7| B ToReady_pad_0_i Il sysClk System - Edge ~ Single Rise - ]
o | B ToReady_psd 10 [l sysck System ~ Edge ~ Single Rise - e dy_max
| B usb_vbus_pad_0_1 [l sysCik System ~ Edge = Single Rise - Rise Min = tca_min + troe_dly_min
| B usb_vbus pad 1.0 [l sysClk System ~ Edge ~ Single Rise -
| @ orl200_cmode [l VIRTUAL cpuClk_5 System = Edge = Single Rise -
| B orl200_pic_ints . VIRTUAL cpuclk_5 System ~ Edge = Single Rise - . 4
o | B reset M. VIRTUAL_cpuClk_5 SyEtem ~ Edge ~ Single Rise * | _ apply |

% Tel Command Preview (49) @& Existing Set Input Delay Constraints (0 B Waveform - System | Edge | Single Rise

input clock /4 \ r‘ / S —
NN O YRR

» (tco_min + tree! diy_min)
» (tco_max + tree_dly_max)

| Reference | | <ok | Med> || SkiptoFinish>> | | cancel |

Figure 8: Inputs page of timing constraints wizard showing the major sections
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10. Fill out the form based on Table 2.
11. Skip entering a few constraints by unchecking the box to the left of the constraint.
In this particular case, you false path these constraints later.

The blocks of colored rows in Table 2 can all be entered at the same time by selecting multiple rows
in the wizard and then entering the values once. Some inputs are constrained relative to virtual
clocks, since they are captured by an internal generated clock with a waveform different than the
board clock. In this case, the wizard creates a virtual clock with the same frequency and waveform
as the internal clock, and recommends a constraint relative to the virtual clock.

Table 2: Input Constraint Values

Interface Clock Synchronous | Alignment Data Rate tco_min | tco_max | trce_dly_min trce_dly_max
and Edge
GTPRESET_IN mgtEngine/... System Edge Single Rise Uncheck constraint — will false path later
GTPRESET_IN mgtEngine/... System Edge Single Rise Uncheck constraint — will false path later
GTPRESET_IN mgtEngine/... System Edge Single Rise Uncheck constraint — will false path later
GTPRESET_IN mgtEngine/... System Edge Single Rise Uncheck constraint — will false path later
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12. Figure 9 shows the completed input delay page. Note the four constraints being skipped.

13. When you have successfully entered all the input constraint values, click Next.

#.- Timing Constraints Wizard =
Input Delays

Input delays describe relative phase between reference clocks (usually board clocks) and input signals at the FPGA boundary. Inaccurate input delay values can '
make timing fail and affect implementation quality of results. More info

Recommended Constraints

e 1 ol a1 s
h- Interface Clock Synchronous  Alignment  Data Rate and Edge PelatiRataklers
Di\*- I:‘ B GTPRESET_IN Il mgtEngine/...OUTCLK_OUT  System Edge Single Rise * | Clock period: 10 ns
| |:| B GTPRESET_IN Il mgtEngine/...OUTCLK_OUT  System Edge Single Rise tco_min: 1 7T
- D B GTPRESET_IN Il mgtEngine/...OUTCLK_QUT  System Edge Single Rise
= [C] » GTPRESET_IN NIl mgtEngine/...OUTCLK_OUT  System Edge Single Rise tco_max: 2 |ns
B4 [» Reactive_pad_0_i sysClk _ tree_dy_min: 1 |ns
[¥] & RxError_pad_0_i I sysClk System ~ Edge ~ Single Rise
—| | trce_dly_max: 1 ns
[¥] O rxvalid_pad_0_i Il sysClk System ~ Edge ~ Single Rise v =
O TxReady_pad_0_i I sysClk System ~ Edge ~ Single Rise -
O TxReady_pad_1_i TN sysClk System ~ Edge ~ Single Rise -
Cr RxValid_pad_1_i Il sysClk System ~ Edge ~ Single Rise A
O usb_vbus_pad_1_i [l sysClk System ~ Edge ~ Single Rise -
- usb_vbus_pad_0_i N sysClk System ~ Edge ~ Single Rise M | e e dly_max
O RxError_pad_1_i I sysClk System ~ Edge ~ Single Rise A Rise Min = tco_min + trce:d\y;nin
Cr RxActive_pad_1_i I sysClk System ~ Edge ~ Single Rise -
2 LineStat...d_0_i[*] [l sysClk System ~ Edge ~ Single Rise -
B vstatus_pad_0_i[*] [l sysCk System ~ Edge ~ Single Rise -
T Appl
[¥] B vStatus_pad_1_i[*] ]Il sysClk System ~ Edge ~ Single Rise v -

% Td Command Preview (41) | & Existing Set Input Delay Constraints (0 B Waveform - System | Edge | Single Rise

input cock / \ / \

H 1
_—> (tco_min + treeldly_min)
» (tco_max + tree_dly_max)

data

[ < Back ” Next > ][ Skip to Finish => ] [ Cancel

Figure 9: Completed Inputs Page of the Timing Constraints Wizard

The output page of the wizard displays all the outputs that are unconstrained in the design. The
page layout is very similar to the inputs page.
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Select the template in section A, enter the values in section B, and observe the Tcl commands,
existing output delays, and the template specific waveform in section C. Use Table 3 below to
constrain all the outputs. You can select multiple lines in the wizard at once and edit several entries
at the same time.

Table 3 is shaded to indicate which groups of signals can be entered in this manner.

Table 3 : Output Constraint Values

Interface Clock Synchronous | Alignment Data Rate tsu thd trce_dly_max | trce_dly_min
and Edge

15.
16.

17.

18.

19.

Click Next to continue.

The wizard then looks for any unconstrained combinational paths through the design. A
combinational path is a path that traverses the FPGA without being captured by any sequential
elements. This design does not contain any combinational paths. Click Next to continue.

Physically exclusive clock groups are clocks that do not exist in the design at the same time. There
are no unconstrained physically exclusive clock groups in this design. Click Next to continue.

Logically exclusive clocks with no interaction are clocks that are active at the same time except on
shared clock tree sections. Then these clocks do not have logical paths between each other and
outside the shared sections, they are logically exclusive. There are no unconstrained logically
exclusive clock groups with no interaction in the design. Click Next to continue.

Logically exclusive clocks with interaction are clocks that are active at the same time except on
shared clock tree sections. When these clocks have logical paths between each other, only the
clocks limited to the shared clock tree sections are logically exclusive and are therefore constrained
differently than the logically exclusive clock with no interaction. There are no unconstrained
logically exclusive clock groups with interaction in the design. Click Next to continue.
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20. The Asynchronous Clock Domain Crossings page recommends constraints for safe clock domain
crossings. This design does not contain any unconstrained clock domain crossings. Click Next to
continue.

21. Figure 10 shows the final page of the timing constraints wizard. All the constraints that were
generated by the wizard can be viewed by clicking the links. If you would like to run any reports
once the wizard is finished, you can select them.

ﬁl“..'-'_:- Timing Constraints Wizard @

Constraints Summary

() The Timing Constraints Wizard created 83 new kiming constrainks:
Create Clock (73
Set Input Delay (387
Set Qubput Delay (35)

On Finish
Save Constraints to Targek XD
Wiews Timing Conskrainks
Create Timing Summary report
Create Check Timing report
Create DRC repart using only timing checks

V | VAD O ‘ The new constraints are applied to the design in memory only, To save them to your target %0C File,
» click Save Constraints after completing the wizard, To keep the new constraints and perform the

selected actions, click Finish, To discard the constraints, click Cancel,

< Back Mext > |f Finish d | Cancel

Figure 10: Timing Constraints Wizard Summary Page

22. Click Finish to complete the timing constraints wizard.
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Lab 1: Defining Timing Constraints

23. The timing constraints wizard creates all timing constraints in-memory. To save the constraints to
disk, you must click the save icon from the main Vivado toolbar as shown in Figure 11.

¢ project_cpu_netlist - [C:;/Data/Viv:

File gw Tools Window Layc
F. i X 4D
Flow Mayigate «

s

4 Project Manager
@ Project Settings

= @

i

Figure 11: Save Constraints to Disk

Important! You must use the Save Constraints command to save any constraint
changes to the timing.xdc file.

Step 4: Using the Constraints Editor

1. Select Edit Timing Constraints from the Flow Navigator under the Synthesized Design section. The
Vivado IDE displays the Timing Constraints window.

There are three sections to the Timing Constraints window:

0 Constraints tree view is labeled section “A” in Figure 12. This section displays standard

timing constraints, grouped by category. Double-clicking a constraint in this section opens a
form to help you define the selected constraint.

0 Constraints Spreadsheet is labeled as section “B" in Figure 12. This section displays timing
constraints of the type currently selected in the Constraints tree view. If you prefer, you can
use this to directly define or edit constraints instead of using the Constraints wizard.

0 All Constraints is labeled as section “C" in Figure 12, this section displays all the timing
constraints that currently exist in the design.
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E Project Summary X | @ Device  x |i4 Timing Constraints  x: O =
e & @ Create Clack

- + Position  Clock Mame Petiod (ns)  Rise At {ns) Fall At {ns) Add Clock  Source Objects
- ] mgtEngineROCKE... 12,800 0.000 6,400 [l [get_pins rmgtEngine/ROCKE
@ 2 mgtEngine ROCKE. .. 12,800 0,000 6,400 [ [get_pins mgtEngine/ROCKE
+Set Clock Latency (0] &3 mgtEnginefROCKE. .. 12,800 0.000 5400 [|  [get_pins mgtEngine/ROCKE
~Set Clock Uncertainty (0) = & 4 mgtEnginejROCKE. .. 12.800 0.000 6.400 [  [get_pins matEnginefROCKE
+Set Clack Groups (1) 25 sk 10.000 0,000 5000 [] [get_ports sysClk]
~Set Clock Sense (0 &6 WIRTUAL cpuclk S 20,000 0.000 10.000 [
~Set Input Jitter (0 £ 45 WIRTUAL whClhk_4 20,000 0.000 10.000 [
~Set System Jitter (1) i Double chick ko creabe a Create Clock conste aink
St External Delay (0)
=-Inputs (35 LAE B
i beSet Inp lay (35)
El-Oukputs (55
¢ Loget Qukput Delay (38)
EI--\F\ssertinns ()] -
i L.Set Data Check (0 = < | 1 =

Al Constraints

a, BBy timing.xdc (i Users/frederi/Documents) YivadoDoc) 2014, 5/1UG945 project _cpu_netlist/project_cpu_netlist.sres/labl newtiming, xdc) -
= - 1, create_clock -period 12,800 -name mgtEngine/ROCKETIO_WRAPPER,_TILE_i/gt0_ROCKETIO_WRAPPER,_TILE_i/GTO_TXOUTCLE_OUT -wavel |
cha -~ 2, create_clack -period 12,800 -name mgtEngine/ROCKETIO_WRAPPER _TILE_i/gt?_ROCKETIO_WRAPPER _TILE_j/GT2_TXOUTCLE_OUT -wave
= - 3, create_clock -period 12,800 -name mgtEngine/ROCKETIO WRAPPER,_TILE_i/gt4_ROCKETIO_WRAPPER_TILE_j/GT4_THOUTCLE_COUT -wave
D; -4 4, create_clock -period 12,800 -name mgtEngine/ROCKETIC _WRAPPER _TILE_j/gté_ROCKETIO \WRAPPER_TILE_ifGTE_THOUTCLE_OUT -wave

- {4, 5. create_clock -period 10,000 -narme sysCIk@aveForm 40,000 5,000} [get_ports sysClk]
@ - 6, create_clock -period 20,000 -name YIRTUAL _cpuClk_S -waveform 40,000 10,000
»® -8, 7. seb_input_delay -clock [get_clocks sysClk] -min -add_delay 2.0 [get_ports {Dataln_pad_0_i[*]}]

= -~ B.set_input_delay -clock [get_clocks sysCIk] -max -add_delay 3.0 [get_ports {Dataln_pad_0_i*]+]

& - 9. set_input_delay -clock [get_clocks sysilk] -min -add_delay 2.0 [get_ports {Dataln_pad_1_i[(*]}] o

4| i1 A=

Apply Cancel

Figure 12: Timing Constraints window

2. The timing constraints wizard identifies missing clocks, I/O delays, and clock domain crossings
exceptions, but it does not handle general timing exceptions. You are going to use the timing
constraints editor to create the exceptions that exist in this design.

3. First, you are going to set a false path on the GTPRESET_IN input. This is the input that you
unchecked on the input delay page of the timing constraints wizard.
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4. In the Constraints Tree view, scroll down to the Exceptions section.

5. Double-click Set False Path under the Exceptions category of the tree as shown in Figure 13.

Using Constraints

L Project Summary ¥ | @ Device X | £ Timing Constraints X
= = | B b

© ST SYSEm JIwer (0] &
. -Set External Delay (C % Position
[=-Inputs (38) i
. -Set Input Delay (38)
[=-Qutputs (38)
. -Set Output Delay (38
[=-Assertions (0 r
. ‘-Set Data Check (0]
[=Exceptions (0]
. --Set Case Analysis (0
et e o (0
-Set Multicycle Path (1=
-Set Maximum Delay
- ~-Set Minimum Delay |
[=-Others (0]
~Group Path (0) i
“--Set Disable Timing (1 ~
P P— | — =1 EL 11}

Set False Path

Setup/Hold  Rise/Fall

Double click to create a Set False F

Figure 13: Set False Path Section in the Constraints Editor
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6. In the Set False Path window, to the right of the From text box, click the u button as shown in

Figure 14.

Lab 1: Defining Timing Constraints

# Set False Path

Targets Oplions
Start Points

Erom: |
Therowsgh Points

1. Through:

More

End Points

Ta:

Command: sat_falsa_path

Reference

Define false paths in the design that are not considered during timing anabyss,

QK

4

Cancel

7. A Choose Start Points window will appear. In this window change the pull-down Find names of

type to ports as shown in Figure 15.

Figure 14: From Box

8. In the with pattern text box, enter GTPRESET _IN*.

9. Click the Find button.

10. Select GTPRESET_IN in the find results text box and press the right arrow to move it to the selected

names text box.

Notice that the Command field displayed at the bottom of the dialog box changes as you perform
these different actions. The get_ports command changes to:

get_ports GTPRESET_IN
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Find names of ty

Options
@ With pattern:

Of these objects:
Filter Matching Names
@) with direction: (any) =

With expression:

| Ignore command errors

[ = End

Find results: 134 Selected names: 1

@ STFRESET_IN
=

@
&

Command: get_ports GTPRESET_IN

Concatenate commands of these types:  pins

ee9ee

oK | cancel

Figure 15: Choose Start Points Window for set_false_path Dialog Box

O TIP: You can also double-click GTPRESET_IN to move it from Find results to
Selected names.

11. Click OK in the choose start points window

The completed set false path form is shown in Figure 16. Notice the Command: field at the bottom

of the window:

set_false path —from [get ports GTPRESET_ IN]

The Vivado IDE displays the Tcl command form of all constraints created via the dialogs for your
review. This is useful for learning the Tcl command syntax, and for verifying the final constraint

before adding it.
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4. Set False Path

Targets | Options

Start Points

Through Points

1. Through:

End Foints

To:

Erom: | [get_ports GTPRESET_IN]

Command: | set_false_path -from [get_ports GTPRESET_IN]

[ Reference H Reset to Defaults I

(=]

Define false paths in the design that are not considered during timing analysis.

E]Transit\on riseffall -

E] Transition | rise/fall

E] Transition | rise/fall

y)

Figure 16: Completed set_false_path constraint window

12. Click OK to close the Create Clock wizard, and create the false path constraint as shown in Figure 17.

Using Constraints

L Project Summary X | § Device X | £ Timing Constraints x %
IS Set False Path
~SETSYSIeM er (17| a0 i -
'--5et External Delay (C Position  Setup/Hold Start Points Transition (Start)
- Tnputs (38) | W [lget ports GTPRESE.. Jrise/fall [ |
- Set Input Delay (38) le click to create a Set False Pai
[=-Outputs (38)
~Set Qutput Delay (38
[=-Assertions (1) 7l
~Set Data Check (1)
[=-Exceptions (1)
+Set Case Analysis (0
- |
L--Set Multicycle Path (I~
- Set Maximum Delay
-Set Minimum Delay (|
[=-Others (0)
~Group Path (0) L
~Set Disable Timing (I =
P ] m— A= <[ 11} Q=)
All Constraints
a & 75. set_output_delay -clock [get_clocks sysCIk] -min -add_delay 0.0 [get_ports XcvSelect_pad_0_o] Fa
=a & 76. set_output_delay -clock [get_clocks sysCIk] -max -add_delay 0.2 [get_ports XcvSelect_pad_0_o]
Z & 77. set_output_delay -clock [get_clocks sysClk] -min -add_delay 0.0 [get_ports XcvSelect_pad_1_o]
= & 78. set_output_delay -clock [get_clocks sysClk] -max -add_delay 0.2 [get_ports XcvSelect_pad_1_o]
E’; & 79. set_output_delay -clock [get_clocks sysClk] -min -add_delay 0.0 [get_ports phy_rst_pad_0_o]
& 80. set_output_delay -clock [get_clocks sysClk] -max -add_delay 0.2 [get_ports phy_rst_pad_0_o]
@x £ 81. set_output_delay -clock [get_clocks sysClk] -min -add_delay 0.0 [get_ports phy_rst_pad_1_o]
¥ | @ 82. set_output_delay -clock [get_clocks sysClk] -max -add_delay 0.2 [get_ports phy_rst_pad_1_o]
=5 <unsaved constraints> (1)
@ -
[ S —— Q=

Apply

Figure 17: New set_false_path constraint in the constraint editor
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13. Next we are going to add a multicycle path using the constraints editor

a. Double click on Set Multicycle Path under the Exceptions category of the tree

b. In the Set Multicycle Path window, change the Path Multiplier to 2.

¢. Inthe Through Points and Transitions entry box, type the following string:

[get _pins cpuEngine/orl200 cpu/orl200_alu/*]

d. Click OK. A new multicycle path will be added to the constraints editor in the
<unsaved_constraints> section as shown in Figure 18.

T Project Summary X | @ Device X | & Timing Constraints X O

= = | E
: \..Set External Dielay (03 &
= puks (35)

i eSet Input Delay (38)
EJ-Cutputs (35

¢ L.Set Output Delay (38
é--ﬁ.ssertions ()} o
: L.Set Data Check (D)
ceptions ()

--Gek Case Analysis (07

m

i -Set Minimum Delay (0)
E1-Others (0}
E—----Group Path (0} =
--Set Disable Timing (0) =

All Constraints

@

78, set_output_delay -
79, set_output_delay -
&0, set_outpuk_delay -
31, set_output_delay -
&2, set_output_delay -
33, set_output_delay -
zunsaved constraints>

€ | B | B B4 P

i3 84, set_false_path -from [get_ports GTPRESET_IM]

set_multicycle_path -through [get_pins cpuEnginefor1200_cpufor1200_aluf*] 2
T ] 3

Set Multicycle Path

+ Position  Path Multiplier  Setup/Hold — Start/End Skart Points Through Points and Transition

- M _ _ _ _ -through [get_pins cpuEngine/or 1 200_cpufor1200_alu*]

Double dlick ko creake & Sab Mulbicycls Path constraint

clock [get_clocks sysiClk] -min -add_delay 0.0 [get_ports ¥cvSelect_pad_1_ao]
clock [get_clocks sysClk] -max -add_delay 1.1 [get_ports XcvSelect_pad_1_o]
clock [get_clocks sysClk] -min -add_delay 0.0 [get_ports phy_rst_pad_0_n]
clack [get_clocks sysiClk] -max -add_delay 1.1 [get_parts phy_rst_pad_0_ao]
clock [get_clocks sysClk] -min -add_delay 0.0 [get_ports phy_rst_pad_1_n]
clock [get_clocks sysiClk] -max -add_delay 1.1 [get_parts phy_rst_pad_1_o]

O] 4 [

Apply Cancel

Figure 18: New Multicycle Path Added to the Constraints Editor

14. Adding a multicycle path by default pushes the setup timing to the specified number of cycles (N),

but it also pushes the
cause Vivado tools to

hold timing to N — 1 cycles. This is usually not what is intended and could
spend a lot of time fixing large hold violations. In this case we want the setup

path to be timed to two cycles of the clock, but we want the hold path to be timed to zero cycles of

the clock. To achieve
that

N —1is zero. For mo
Guide: Using Constrai

this, we need to define another multicycle path on the hold edge to 1, such

re information about this situation, please refer to Vivado Design Suite User
nts (UG903).

a. Double click on Set Multicycle Path under the Exceptions category of the tree for a second

time.
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Lab 1: Defining Timing Constraints
Note that all the fields you entered previously are still filled in

In the Set Multicycle Path window, change the Path Multiplier to 1

Select the Options tab

Check the box that says Use path multiplier for hold (minimum delay) calculation.

Click OK

We now have a fully constrained design in memory. Saving the constraints to disk is covered in Step 5.

Step 5: Saving Constraints

Constraint management is an important step of the design flow, and the Vivado Design Suite provides
you the flexibility of adding new constraints into an existing constraint file, overwriting existing
constraints, or creating a new constraints file to track design changes or complete missing constraints.

You have created a few timing exceptions for the design, but the constraints exist only in memory and
not on disk yet. You need to save the constraints to the timing.xdc file.

1. From the Sources view in Vivado, double-click timing.xdc under Constraints > labl

2. Scroll to the bottom of the file and notice that the set_false_ path and
set_multicycle_path constraints do not exist in the file. This is also reflected in the Timing
Constraints Editor as unsaved_constraints, as shown in Figure 19.

E Project Summary X | @ Device X | (7 Timing Constraints X O =
Z % ,'riL\ @ Set Multicycle Path
i toSetInput Delay (38) - + Paosition  Path Multiplier  Setup/Hold  Start/End Start Points Thraugh Paints and Transition

[=-Others (0

'r'*r".l}|

x| “ef 86, set_multicycle_path -hold -through [get_pins cpuEngine/or 1200_cpujor 1200_aluf*] 1 -

ukputs (55

L.-Set Oukput Delay (38)
ssertions (0]

L..Sgt Data Check (0)

|85 2
& 86 1 hald
Double click ke craate & 52k Mulkicydle Path constraint

-through [get_pins cpuEngineor 1200_cpujorl 200 _alui™*]
-through [get_pins cpuEngineor 1200_cpufor1 200_aluf™*]

Set Case Analysis (0)
Set False Path (1)

Mammum Delay (D)
Sek Minirmum Delay (0)

E—----Group Path (0} =
i..5et Disable Timing (0} = 4 m =

All Constraints
e gd 80, set_oukput_delay -clock [get_clocks sysCIk] -min -add_delay 0.0 [get_ports phy_rst_pad_0_o] -
& 81, set output _delay -clock [get_clocks swsClk] -max -add_delay 1.1 [get_parts phy_rst_pad_0_a]

oot delay -clock [get_clocks swsClk] -min -add_delay 0.0 [get_ports phy_rst_pad_1_o]
33, set_output_dela? -max -add_delav 1.1 [get_porks phy_rst_pad_1_o]

----- ,@, 85, =et multlcycle;ath -through [get_pins cpuEnglne,l'orlZDD _cpufor1200_alyf*] 2

] [ (=]

Apply Cancel

Figure 19: Unsaved Constraints Displayed in the Constraints Editor.
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3. Click the Save Constraints button, or use the File > Save Constraints command from the main
menu. File Edit Flow

=0

Flowr Mavigator
4. Click the Reload banner in the timing.xdc tab to reload the constraints file from disk. Notice that
the false path and multi-cycle paths are now visible in the text file, as shown in Figure 20.

E Project Summary X | @ Device X | & Timing Constraints X | £ timingxde X O¢ X
=] C:fXilinx/Vivado/2014.3/examples/Vivado_Tutorial/Projects/project_3/project_3.srcs/lab1/new;/timing.xdc
@) This file has been changed. Reload

66 set_output_delay -clock [get_clocks sysClk] —min -add delay 0.000 [get_ports TermSel pad 1 o] B
. |67 set_output delay -clock [get clocks sysClk] -max -add_delay 0.200 [get ports TermSel_pad_1_o]
“#| 62 set_output_delay -clock [get_clocks sysClk] -min -add delay 0.000 [get_perts TxValid pad_0_o]
3| 69 set_output_delay -clock [get clocks sysClk] -max -add_delay 0.200 [get ports TxValid pad_0_o]
%[ 70 set_output delay -clock [get_clocks syaClk] -min -add_delay 0.000 [get ports TxValid pad 1 o]
71set_output delay -clock [get clocks sysClk] -max -add_delay 0.200 [get ports TxValid_pad_1_o]
set_output_delay -clock [get_clocks sysClk] -min -add delay 0.000 [get ports VControl Load pad 0 o]
set_output_delay -clock [get clocks sysClk] -max -add delay 0.200 [get ports VControl Load_pad_0_o]
set_output_delay -clock [get_clocks sysClk] -min -add delay 0.000 [get ports VControl Load pad 1 o]
set_output_delay -clock [get clocks sysClk] -max -add delay 0.200 [get ports VControl Load_pad_1_o]
set_output_delay -clock [get_clocks sysClk] -min -add delay 0.000 [get ports XevSelect pad 0 o]
77 set_output_delay -clock [get clocks sysClk] -max -add_delay 0.200 [get ports XcvSelect_pad_0_o]
set_output_delay -clock [get_clocks sysClk] -min -add delay 0.000 [get ports XevSelect pad 1 o]
79 set_output_delay -clock [get clocks sysClk] -max -add_delay 0.200 [get ports XcvSelect_pad 1 o]
20 set_output_delay -clock [get_clocks sysClk] —min -add delay 0.000 [get_ports phy rst pad 0 o]
21 set_output delay -clock [get clocks sysClk] -max -add_delay 0.200 [get ports phy_rst_pad_0_o]
22 set_output_delay -clock [get_clocks sysClk] —min -add delay 0.000 [get_ports phy rst pad 1 o]
23set_output delay -clock [get clocks sysClk] -max -add_delay 0.200 [get ports phy_rst_pad_1_o]
84

85

T

o
£

F
¥

< Tl v

Figure 20: timing.xdc Tab

Step 6: Clock Interaction Report

After or during constraints creation, you must verify that the constraints are complete and safe. Vivado
Design Suite times all clocks together by default unless you specify otherwise by defining clock groups
or other timing exceptions. The set_clock_groups command specifies asynchronous or exclusive
clock domains and disables timing analysis between them. You can also use set_false_path
between two clocks to disable timing on all paths between them, or use it on specific netlist objects to
only disable some paths. The set_multicycle_path constraint modifies the clock edges used
during timing analysis instead of the default single cycle assumption. For more information on using
these constraints refer to the Vivado Design Suite User Guide: Using Constraints (UG903).

Vivado automatically infers timing path requirements for paths that cross between two different clock
domains, called inter-clock paths, making assumptions regarding phase and offset. The Report Clock
Interaction command reports inter-clock paths, to help identify potential problems such as unrealistic
setup or hold requirements between two clocks, or unsafe timing between asynchronous clocks (no
known phase relationship) which can lead to unstable hardware behavior.

1. In the Netlist Analysis section of the Flow Navigator, under Synthesized Design, select Report
Clock Interaction and click OK in the Report Clock Interaction dialog box to accept the default
settings.
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"
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y
g
g phyclko_2
@ phyClk1_1
sysClk
usbCll_3
VIRTUAL _cpucCll_S
whbClk_4
M No Path [ User Ignored Paths [] Fartial False Path [ Partial False Path (unsafe)
W Timed W Timed (unsafe) [ Max Delay Datapath Only
E
Source Destination Edges Failing Total PathReq  Edges Failing Total PathReq  Common  Inter-Clock
kS Clock Clock (whns) ~ WNS(ns) THS(nS)  pogngine. Endpoint.. (whs)  (whs)  WHS(0S) THS(MS)  pogadint. Endpoint.. (WHS)  Primary.. Constrai..
1 sysClk phyClkl_1 rise - rise  3.666 0.000 0 23 10.000 rise - rise  3.029 0.000 0 23 0.000 Yes Timed -
2 sysClk phyClkd_2 rise - rise  3.666 0.000 0 23 10.000 rise - rise  3.029 0.000 0 23 0.000 Yes Timed
3 VIRTUAL_... wbClk_4 rise - rise  15.584 0.000 0 176 20.000 rise - rise  1.225 0.000 0 176 0.000 Virtual Timed
4 VIRTUAL_... cpuClk_5 rise - rise  14.106 0.000 0 834 20.000 rise - rise  1.201 0.000 0 834 0.000 Virtual Timed
5 mgtEngin... mgtEngin... rise - rise  10.126 0.000 0 222 12.800 rise - rise  0.178 0.000 0 222 0.000 Yes Timed
6 mgtEngin... mgtEngin... rise - rise  10.126 0.000 0 222 12.800 rise - rise  0.178 0.000 0 222 0.000 Yes Timed
7 mgténgin... mgtengin... rise - rise  10.126 0.000 0 222 12.800 rise - rise  0.178 0.000 0 222 0.000 Yes Timed B
f# matFnain..._matFnain..._rise - rise__ 10.126 0.000 n 222 12,800 rise - rise__ 0178 000 n 222 0000 Yes Timed =)

Figure 21: Clock Interaction Report

The Vivado IDE generates a graphical matrix illustrating the relationship of the various clocks in the
design, as shown in Figure 21. For this design, the primary clock (sysClk) connects to an MMCM,
which generates six additional clocks. The clock interactions shown are between these generated
clocks. In addition, the timing constraints wizard created a few more generated clocks and virtual
clocks to fully constrain the design.

The Clock Interaction report shows clock pairs with no path between them (black), with paths safely
timed (green and light blue), with paths not safely timed (reg and orange) and with paths covered
by Max Delay Datapath Only constraints.

ﬁ Important! Green in the matrix does not mean that timing is met, it simply means
that the timing constraints and the clock tree topologies allows safe timing analysis
and accurate slack computation.

In the Clock Interaction report, unsafe means there is no common primary clock (no known phase
relationship) or no common clock period within the first 1000 clock cycles of the source and
destination clocks . The Vivado timing engine selects edges on the launch and capture clocks based
on the first 1000 cycles, but these edges may not reflect the most pessimistic analysis between the
clocks.

O TIP: The colors described here are the default colors. Your colors may be configured
differently from those shown in Figure 21.

2. Close the Clock Interaction window by clicking the % in the window tab.
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Step 7: Timing Summary Report

Timing paths start and end at clocked elements. Input and Output ports are not sequential elements,

and by default Vivado timing analysis does not time paths to or from I/O ports in the design, unless
input/output delay constraints are specified.

In this step you will generate and observe timing reports in Vivado.

1. Select Tools > Timing > Report Timing Summary; leave the default options.

2. Press OK to generate the report.

The timing summary tab will open as seen in Figure 22.

Tirning - Timing Surnrnary - timing_1
ATHeEr 2R

‘General Infarmation

+-Check Timing (%)
+-Intra-Clack Paths

+ -Inter-Clock Paths
%—--Other Fath Groups
;--User Ignored Paths
- Unconstrained Paths

Timing Summary - timing_1 X

= Tel Console [ Log

) Messages

»
Setup

12 Reports

4 Design Timing Surmmary

Hald

Warst Megative Slack (WHS):
Takal Negative Slack (THS):

2.847 ns worst Hold Slack (WHS):
Total Hold Slack (THS):
Mumber of Failing Endpaints: 791

46377

-0.145 ns
0.000 ns -13.291 ns
Mumber of Failing Endpaints: 0

46377

Takal Number of Endpaints: Total Mumber of Endpaints:

Timing constraints are not met.

3» Design Runs (3 Timing

Figure 22: Report Timing Summary Results

— 0O @ =x
Pulse YWidth
Warst Pulse Width Slack (WPWS): 3.000 ns
Total Pulse Width Megative Slack {TPWS):  0.000 ns
Mumber of Failing Endpoints: o
Total Mumber of Endpaints: 16037
4+ B

3. This design passes setup timing but fails hold analysis. Before implementing the design, timing
analysis uses estimated net delays that represent ideal placement. Small hold violations are

common at this point of the flow and will be fixed during the routing step. For now, let us review
the content of the report. Click on the Worst Negative Slack link in the design timing summary

section to see the worst timing path in the design.

Figure 23 shows the worst path in the design.

Timing - Timing Summary - timing_1
N TTEY T T

WLCIR_ T 0 VIS T OAC_CPUSii_d )

+-phyClkn_2 to sysClk
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; phyclidl_L o sysClk ? B --E' gine/o.../DBDI12] | 6433 1.335] 5.098Jusbclk 33
| [FhusbClk_3 to sysClk =|: %|# Path3as 3.243 85 ushEngined...inta_req/C cpuEngine/o...36/DIBDILO] 6.158 1.335 4.823 usbClk_3
- EVIRTUAL_cpuclk_5 to couctk 5|~ | # Path347  3.385 13 85 usbEngine0...inta_reg/C cpuEngine/o...36/DIADIS] 6.016 1.335 4.681 ushClk_3
fftClk_0 to cpuClk_5 B3 path 348 3.405 17 85 usbEngineq...inta_req/C cpuEngine/o...o_reg[2]/D 6.595 1.830 4.765ushClk 3~
hy€lko_2 to cpuclk_5 © @ Path340  3.405 17 85 usbEngineD...inta_reg/C cpuEnginefo...th_o_reg/D 6.595 1.830 4.765 usbClk_3
; Erphyclkl_L to cpuclk_5 # Path 350 3.445 13 85 usbEngineD...inta_reg/C cpuEngine/o...36/DIADI 0] 5.056 1.335 4.621 usaClk_3
: ErusbClk 3 to cpuclk 5 ¥ Path 351  3.453 13 85 usbEnginel...inta_reg/C cpuEngine/o...36/DIADI[0] 5.048 1.434 4.514 usbClk_3
! ---m 2.968 ns (10 T = e 7 i e —r o e P e
< ] A= 4 11 =)
Timing Summary - timing_1 x 4B
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Figure 23: Worst Timing Path in the Design
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4. When the worst path is selected, press F4 to bring up its schematic. Figure 24 shows the worst
setup path in the design.

M
e

L Project Summary X | @ Device X | Schematic x O
3| 25Cells 35 Nets

L -
=

W

+

B/ (X}

Figure 24: Schematic of Worst Setup Path in the Design

5. Inthe timing summary tree, select Check Timing.
e There are nine issues flagged by Check Timing shown in Figure 25.

e Eight of these are pulse_width_clock checks which were also flagged by the timing
constraints wizard, but were not constrained. These violations have low severity because the
corresponding missing clocks are not needed for timing logic paths.

e The remaining issue flagged by Check Timing is a missing input constraint on the reset signal
that was set to false_path. This can also be ignored.

Timing - Timing Summary - timing_1 — 0O X
AT S & kg 4 Check Timing
i Ha —
~General Information A Timing check Count  Worst Severity
+Timer Settings
--Design Timing Summary pulse_width_clock 8 @ Low p
i.Clock Summary (13) no_input_delay 1 & Medium
E 8 Checl g : no_clock i} L
+}-Intra-Clock Paths constant_clock 0
+-Inter-Clock Paths unconstrained_internal_endpoints 0
1-Other Path Groups no_output_delay i
+ User Ignored Paths multiple_clock 0 i
+ Unconstrained Paths Igenerated_clocks 0
nane n
Timing Summary - timing_1 X 90@

2 Td Console | = Messages | (4 Log | [% Reports | 3 Design Runs (3 Timing

Figure 25: Check Timing Results in the Timing Summary Window

Using Constraints www.xilinx.com l Send Feedback I 29
UG945 (v2014.3) November 7, 2014


http://www.xilinx.com/
http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG945&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Using%20Constraints&releaseVersion=2014.3&docPage=29

& XILINX

ALL PROGRAMMABLE, Lab 1: Defining Timing Constraints

6. Inthe timing summary tree, select the Clock Summary, as shown in Figure 26. The clock summary
section of the timing summary report lists all the clocks in the design and shows the resulting
frequencies and waveforms of each clock. The hierarchy shows the relationship between the
generated clocks and the primary clock (for example, cpuClk_5 vs. sysClk).

Timing - Timing Summary - timing_1 [ i B E

= - lkg 4 Clock Summary
~-General Information
--Timer Settings

]
Design Timing Summary & +VIRTUAL_cpuClk_5 {0.000 10.000} 20.000 50.000 &
H m =4| -~ mgtEngine/ROCKETIO_WRAPPER_TILE_i/gtd_ROCKETIO_WRAPPER_TILE_i/GT0_T... {0.000 6.400} 12.800 78.125

+ Check Timing (2) {0.000 5.400% 12.800 78.125 =
F-Intra-Clock Paths {0.000 6.400} 12.800 78.125

r &
A Name Waveform Period (ns)  Frequency (MHz)

(i} Inter-Clock Paths £0.000 6.400} 78.125}
f-Other Path Groups {0.000 5.000} 10.000 100.000
FH-User Tgnored Paths {0.000 5,000} 10.000 100.000 A
HFl-Unconstrained Paths i-cpuclk_s {0.000 10.000} 20.000 50.000
L EEerIl n fo_nnn E nnnl 10 nnn 1N Aann
Timing Summary - timing_1 X 4 E

2 Tdl Console | © Messages | B Log | |2 Reports | 3» Design Runs (G Timing

Figure 26: Clock Summary

7. The remaining sections of the timing summary report group paths by their type. Each section lists
the top ten paths (specified when the report was generated) in that group. These include inter-clock
paths, intra-clock paths, other path groups, user ignored paths, and unconstrained paths. Clicking
the roots will show a summary of the paths beneath. Expanding the tree further will ultimately
display the top timing paths for each group.

Conclusion

At this point you may either continue to Lab #2: Setting Physical Constraints, or exit the Vivado Design
Suite and continue later.

You have learned:

e Creating a constraint set and setting a target constraint file

e How to add timing constraints to a design using the timing constraints wizard

e How to add timing constraints using the timing constraints editor

e The importance of saving constraints to disk versus in-memory constraints

e How to generate the clock interaction report and properly interpret the resulting matrix

e How to generate the timing summary report and properly interpret the results
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Lab 2: Setting Physical Constraints

In this lab, you will create physical constraints for the CPU Netlist design, observing how actions in the
GUI call Tcl commands. Using Tcl commands, complex operations are easily scripted for repeated use,
at various stages of the flow.

Note: If you are continuing from Labl, and your design is open, skip ahead to Step 2: Adding
Placement Constraints.

Step 1: Opening the Project

This lab continues from the end of Lab #1 in this tutorial. You must complete Lab #1 prior to beginning
Lab #2. If you closed the tool, or closed the tutorial project at the end of Lab #1, you will need to open
them again.

1. Start by loading the Vivado Integrated Design Environment (IDE).
e Launch Vivado IDE from the icon on the Windows desktop, or
e Type vivado from a command terminal.
The Vivado IDE opens.

From the Getting Started screen you can open recent projects as listed on the right hand side of the
window.

2. Under Recent Projects, click project_cpu_netlist as shown below.

VIVADO! o i £ XILINX

Quick Start Recent Projects

project_cpu_netlist

A7 y, ) C: /Data/Vivado_Tutorial/project_cpu_netlist
» fi' = > project_cpu_netlist_kintex7
\ / C: fxilinx/Vivade /2014, 1 /examples/Vivado _Tutorial/...

Create Mew Project Open Project Open Example Project project_ipi

C:/Data

m

Aroject o

project_cpu_netlist_kintex7

ojectsfpraject_cpu_netl...

Tasks
v
>

Manage IP Open Hardware Manager Xilinx Td Store

E. project_bft_batch i

3 e =

Recent Checkpoints

Information Center Eosqt‘rmfte.f?f TutarialfT

C:/Data,

Figure 27: Open Recent Projects from Getting Started
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Step 2: Adding Placement Constraints

Explore some of the design hierarchy, and begin placing logic elements to create physical constraints.

1. From the Flow Navigator select Open Synthesized Design.

The synthesized netlist opens with the Device window displayed.

2. Select the Netlist window and expand the clkgen hierarchy.
3. Expand the Leaf Cells folder and select the mmcm_adv_inst MMCME2_ADV).

Netlist

A for]
edg | B

O =

o

-

top
) Nets (4432)
| Leaf Cells
-[@] dkgen (do
-5 Nets |
=+ Leaf Cells (10
-] dkf_buf (BUFG)

-] dkoutl_b
40| dkout?_b G)
-] dkout3_buf (BUFG]
-{i| dkout4 buf (BUFG)
-{i| dkouts_b )

{il] dkouté_buf (BLFG]
GND (GID)

-
-{T] cpuEngine
+-{T] fftEngine (
+! matEngine
+-{d] usbEngined (.
+-{T] usbEngine1 (1
+-{d] wbArbEngine |

B vl inst (H1HCHE2_A0V)

2 Netlist | & Sources

Figure 28: Netlist window

2t Properties

4. Look in the Properties view, under the Properties tab, and notice that the STATUS is UNPLACED, and
there are no 1S_LOC_FIXED or 1S_BEL_FIXED properties shown.

Check this in the Tcl Console by typing:

get _property IS LOC FIXED [get cells clkgen/mmcm_adv_inst]

This returns a zero, indicating the object is not fixed to a location.

Zoom into the bottom right of the Device view, to display the lower half of Clock Region X1YO, to
prepare for placing the selected object. See Figure 29.

Q

Tip: It is easier to place logic in the Device window if Routing Resources are not

displayed. If necessary, select the Routing Resources toolbar button ll to disable

the display of routing resources.
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Figure 29:Placing the MMCM

In the Netlist window, click on the mmcm_adv_inst and drag it into the Device window to place it
into the bottom right MMCME2_ADV.

Look in the Tcl Console. You should see something like these three commands:

startgroup
place_cell clkgen/mmcm_adv_inst MMCME2_ADV_X1YO/MMCME2_ADV

endgroup

The startgroup and endgroup Tcl commands bracket sequences of commands to support the
undo function in the Vivado tools. If you make a mistake, you can use the undo command in the Tcl
Console, or the Edit > Undo command. This will undo the placement and allow you to redo it. For
more information on startgroup, endgroup, and undo, refer to the Vivado Design Suite Tcl
Command Reference Guide (UG835).

Look at the Properties tab of the Cell Properties window for the MMCM cell you placed.

Notice the IS_BEL_FIXED and 1S_LOC_FIXED properties now reflect that the object has been
placed, as shown in Figure 30. The STATUS is FIXED as well.

O Tip: The Cell Drag and Drop mode in the Device window determines whether

IS_LOC_FIXED is set, or 1S_BEL_FIXED is also set, when placing objects. Refer to
the Vivado Design Suite User Guide: Using the Integrated Design Environment
(UG893) for more information on using the Device window.
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Figure 30: BEL and LOC Placement Constraints

The 1S_BEL_FIXED and IS_LOC_FIXED properties on the object are physical constraints
reflecting the placement of the object. These constraint are used by Vivado implementation, and will
not be changed by the tool. However, if the properties are invalid, they will cause errors

downstream in the design flow.

Notice that when you place the mmcm_adv_inst in the Device window, the Save

Constraints icon is enabled. The physical constraints are added to the Vivado tool in-

memory design, but are not yet saved to the target constraint file.

File Edit Flow

EOLT

Flow Navigator

Step 3: Defining Additional Physical Constraints

In this step you will define additional physical constraints to the design, such as the PACKAGE_PIN, and

PROHIBIT constraints.

1. Select the I/0 Planning view layout from the Layout Selector in the tool bar menu.

The I/O Planning view layout displays the Package window, as well as the I/O

Ports and Package Pins windows, to facilitate planning the 1/O port assignment

for the design.

For the purposes of this tutorial, assume the PCB layout has been completed,

and therefore certain pins are not accessible on the FPGA package. You can
prohibit the Vivado tool from using these pins during placement and routing
(assuming you have not already specified all of your I/O assignments).

2. Select the AA8 pin in the Package window.

@
k70

00 pefault Layout -
20 Default Layout

25 Clock Planning

22 Floorplanning

22 Debug

00 Timing Analysis

15 Save As New Layout...

Reset Layout F5

Tip: Use the X and Y-axis values on the edge of the Package window to help you

locate this pin on the package.
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3. With the pin selected, right-click and select Set Prohibit.

Pin: AAS (User I0)
Site Type: I0_LEP_T1 33
Bak: 33 (High Performance)

Figure 31: Package Pin A8

When you unselect the pin, you will notice the site now has a red circle with a diagonal line through
it, indicating it is unusable.

4. Look in the Tcl Console and review the TCL command produced by the Vivado IDE:
set_property prohibit 1 [get_sites AA8]

Step 4: Defining Constraints with Object Properties

You can create timing and placement constraints as you have seen in this tutorial. You can also change
the properties of cells to control how they are handled by Vivado implementation. Many physical
constraints are defined as properties on a cell object.

For example, if you discover a timing issue with a RAM in the design, to avoid resynthesis, you can
change a property of the RAM cell to add in pipeline registers. After confirming with the designer and
validation teams that this is an acceptable approach, you can change the design.

Setting Cell Properties

Because it can be too time consuming and costly to go back to the RTL after synthesis, you can make
changes in the netlist as follows.

1. Select Edit > Find to open the Find dialog box, seen in Figure 32.
a. Specify Find Cells.
b. Under Properties, specify PRIMITIVE_TYPE is BMEM.BRAM
c. Click OK.
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Figure 32: Find dialog box

The Find Results window displays.

2. Select the Show Search command, D\,on the sidebar menu of the Find Results window.

3. Search for ingressLoop, and select the following cell:
fftEngine/fftinst/ingressLoop[7]-ingressFifo/..

In the Properties tab of the Cell Properties window, you can see the DOA_REG and DOB_REG are set

to zero, indicating that the output registers are disabled.

4. Generate a custom timing report from this cell directly from the Tcl Console. The Tcl command to

enter is:

report_timing -from [get cells

fFtEngine/fftinst/ingressLoop[7].-ingressFifo/buffer_ fifo/infer_fifo.block

ram_performance.fifo_ram_reg]

O Tip: You can copy and paste the cell name from the General tab of the Cell Properties window

into the Tcl console.
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5. Inthe upper right corner of the Tcl console, click the Maximize button to — O x
maximize the window and better view the timing report. -

6. In the data path section of the report, 1.800ns is added for this RAM.

EAMB36El (Prop ramb3gel CLEBWRCLE DOBDO[14])

1.800 -0.645 r fftEngine/fftInst/ingressLoop([7].ingressFifo/buffer fifo/infer fifo.block ram performance.
net (fo=2, unplaced) 0.464 -0.17% LfitInst/toBLt[15]_55[0]
DSP42E1 r transformloop[7].ct/x0utReg reg/RA[0]

7. Restore the Tcl Console to its normal size.

8. In the Properties tab of the Cell Properties window, select the DOA_REG and DOB_REG properties
for this cell, and change their values from “0" to “1".
You can see the two set_property commands run in the Tcl Console.

set_property DOA REG {1} [get _cells
{fftEngine/fftinst/ingressLoop[7]-ingressFifo/buffer_fifo/infer_fifo_block
_ram_performance.fifo_ram reg}]

set_property DOB_REG {1} [get _cells
{fftEngine/fftinst/ingressLoop[7]. ingressFifo/buffer_fifo/infer_fifo.block
_ram_performance.fifo_ram_reg}]

9. Rerun the timing report from the selected cell. The Tcl command to enter is:

report_timing -from [get cells
fFtEngine/fftinst/ingressLoop[7].-ingressFifo/buffer_ fifo/infer_fifo.block
ram_performance.fifo_ram_reg]

10. Notice that the data path delay for the RAM is now 0.622ns.

Setting Design Properties

Next, set the configuration mode on the design. This is another property that results in a physical
constraint, in this case a property of the design rather than of a cell. To begin, list all of the properties of
the current design.
1. List the properties of the design in the Tcl Console:

list_property [current_design]

This command returns the list of all defined properties on the current design. To make the list more

readable, you can use the standard Tcl Join command to combine the properties output with “\n”
newline character, resulting in each property displaying on a separate line.

jJjoin [list _property [current_design]] \n

2. The specific property of interest is CONFIG_MODE. To see what values this particular property can
accept, use the list_property_value Tcl command:

jJjoin [list _property value CONFIG_MODE [current_design]] \n

3. Use the Tools > Edit Device Properties command to set the CONFIG_MODE property for the
current design.
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The Edit Device Properties dialog box opens as shown in Figure 33.

ﬁl*;-‘_;. Edit Device Properties @

| Configuration Modes |
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Configuration

- Select up to two device configuration modes. JTAG is always selected. Selecting a check box assigns a mode
Configuration Modes and dicking an image displays details.
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Readhack [] Prohibit usage of the configuration pins as user If0 and persist after configuration
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PROGRAM_B

m

DOME f—

CCLK
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Master Serial

[ Undo all ][ Help ][ QK ]

Figure 33: Edit Device Properties - CONFIG_MODE

4. Select the Master Serial configuration mode as shown, and click OK to close the dialog box.

The Tcl console shows the set_property command that sets the CONFIG_MODE:
set_property CONFIG_MODE M_SERIAL [current_design]

The configuration mode has now been set.

5. Use the get_property command to confirm that the CONFIG_MODE property was correctly set:
get_property CONFIG_MODE [current_design]

The property value M_SERIAL is returned by the Vivado tool.

Using Constraints www.xilinx.com | Send Feedback | 38
UG945 (v2014.3) November 7, 2014


http://www.xilinx.com/
http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG945&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Using%20Constraints&releaseVersion=2014.3&docPage=38

& XILINX

ALL PROGRAMMABLE, Lab 2: Setting Physical Constraints

Step 5: Saving Constraints

Notice that the Save Constraints icon is enabled because there are new design File Edit Flow
constraints. The cell and design properties you modified in Lab #2 have been 2 @
added to the Vivado tool in-memory design, but are not yet saved to the target

K . Flow Navigator
constraint file.

1. Click the Save Constraints button.

The physical constraints you defined over the course of Lab #2 are saved to the target constraint
file.

2. Select the target XDC from the active constraint set in the Sources window to open the file in the
Vivado IDE text editor.

Notice that the six set_property commands you used in Lab #2 are saved to the constraint file.
Only design constraints are written to the XDC file, not the object queries or reporting commands
that you also used in this lab.

3. Look for the following constraints in the open constraint file:

set_property BEL MMCME2_ADV [get_cells clkgen/mmcm_adv_inst]

set_property LOC MMCME2_ADV_X1YO [get cells clkgen/mmcm_adv_inst]

set _property PROHIBIT true [get_sites AA8]

set_property DOA_REG 1 [get_cells

{fftEngine/fftinst/ingressLoop[7]. ingressFifo/buffer_fifo/infer_fifo.block
_ram_performance.fifo_ram_reg}]

set _property DOB REG 1 [get cells
{fftEngine/fftinst/ingressLoop[7].-ingressFifo/buffer_ fifo/infer_ fifo.block
_ram_performance.fifo_ram_reg}]

set_property CONFIG_MODE M_SERIAL [current_design]

4. Exit the Vivado IDE.

Summary

In this lab, you learned how to use both the Vivado IDE and the Tcl Console to create and verify physical
constraints. Most actions performed in the IDE result in Tcl commands being run in the Tcl Console. The
Vivado IDE provides powerful interactive capabilities for developing physical and timing constraints,
which can then be saved to constraint files and reused as needed.
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The information disclosed to you hereunder (the “Materials”) is provided solely for the selection and use of Xilinx products. To the maximum
extent permitted by applicable law: (1) Materials are made available "AS IS" and with all faults, Xilinx hereby DISCLAIMS ALL WARRANTIES
AND CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY,
NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether in contract or tort,
including negligence, or under any other theory of liability) for any loss or damage of any kind or nature related to, arising under, or in
connection with, the Materials (including your use of the Materials), including for any direct, indirect, special, incidental, or consequential loss
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reproduce, modify, distribute, or publicly display the Materials without prior written consent. Certain products are subject to the terms and
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cores may be subject to warranty and support terms contained in a license issued to you by Xilinx. Xilinx products are not designed or
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